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Abstract

Many e-mail systems and Internet processors corrupt and destroy Chinese e-mails such that the Chinese e-mails often become garbage at the receiving end. Handling, especially sending, e-mails with Chinese text safely from Microsoft English Windows through Internet and various e-mail systems is tricky and is substantially more challenging than sending English e-mails. Furthermore, handling Chinese computer files under Microsoft English Windows environment is also tricky with many pitfalls. This paper presents a collection of experience of my friends and myself in the proper procedures to handle Chinese e-mails and Chinese files using PCs running Microsoft English Windows. Website references for handling Chinese e-mails and Chinese documents under Macintosh Operating System (OS) are also given.
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1. Introduction

We, the Chinese-Americans and Chinese-Canadians, have a lot of opportunities to interact with Chinese people, managers and government officials in Asia. To interact with Chinese people in Asia more efficiently in the modern Information Age, we have an increasing need to handle Chinese e-mails and Chinese documents on our PCs running Microsoft (MS) English Windows in USA and Canada. 

However, our ability to handle Chinese e-mails and Chinese documents smoothly under MS English Windows depends on the versions of hardware and software being used. It works under certain combination of these conditions but does not work under other conditions. The newer versions of MS English Windows (e.g., Windows 2000 Professional, ME and XP) have much better multi-lingual capability to make it easier for the users to handle Chinese e-mails and Chinese files. On the other hand, the older versions of MS English Windows (e.g., Windows 98 and 95) have limited capability to handle foreign languages such that the proper procedure to handle Chinese e-mails and Chinese files is much more challenging and tricky.

This article provides a collection of experience of my friends and myself on this topic. This is a living document and is updated periodically when relevant additional information becomes available.

2. Our Computer Hardware and Software

2.1. Our Computer Systems

I am using Microsoft (MS) English Windows 98 Second Edition (SE), MS English Windows 95, MS Office 2000 application software, MS Outlook E-Mail system, MS Internet Explorer (IE) Version 6.0, Dell Dimension Desktop PC, Dell Latitude laptop PC, Compaq desktop PC and Brother MFC (Multiple Function Center) printer. I also use America Online (AOL) e-mail system and Yahoo web e-mail system occasionally.

Other equipment and software used by my friends, contributing to this article, include HP printers, Cannon printer, MS English Windows 98, MS English Windows 2000, MS English Windows ME, MS English Windows XP, MS Outlook Express, Netscape Navigator, Apple/Mac PCs and Apple OS.

3. Equip and Configure Your PC to Handle Chinese Language

If you want to handle a lot of Chinese files and Chinese e-mails on our PC running MS English Windows, then you need to equip and configure your PC with the necessary capabilities summarized in the following sub-sections.

3.1. Chinese Language Support for MS English Windows

Microsoft provides some update software for MS Windows and MS Office Suite for free download at the following websites:

http://v4.windowsupdate.microsoft.com/en/default.asp   (for MS Windows update) and

http://office.microsoft.com/productupdates/   (for MS Office Suite update).

If you click on “Scan for Updates” in the middle of the page, these websites will communicate with your PC for a couple minutes to understand the version and the features of the MS Windows (or MS Office Software Products) in your PC so that it can recommend several categories of updates for your PC. Then this website will show you a long list of possible update items for you to pick and choose.

The list includes supports for Chinese Language (Traditional and Simplified) plus many other languages. 

Users of Microsoft Windows XP Professional Version may find more information on multilingual capabilities of Windows XP Pro at the following website:

http://www.microsoft.com/windowsxp/pro/techinfo/planning/multilingual/default.asp 

You can also do similar downloads and updates for your MS Office Software Products such as MS Word, PowerPoint, Excel, etc.

The following websites provide detailed step-by-step procedure to install Chinese language support for the users of MS Windows 2000 and Windows XP:

http://californiadream.com/workshops/info/win2000Lang/win2000langInstall.html 

http://californiadream.com/workshops/info/winXPLang/winXPlangInstallConfig.html 

3.2. Chinese Language On Internet Explorer

Open up your MS Internet Explorer and pull down the Tool menu, click on Internet Options at the bottom of the menu, then click on Languages button on the second row from the bottom. This will open up a window that shows the language preferences. If Chinese language is not on this preference list, you click on “Add” button to add several versions (e.g., Traditional, Simplified, Hong Kong, Singapore, etc.) of Chinese language to this list. 

3.3. A Chinese Word Processor 

If the printer driver of your printer handles only 1-byte encoded English text but does not handle the 2-byte or 4-byte encoded Chinese characters, then your printer on its own cannot print Chinese text under MS English Windows. The Chinese characters are printed as either blank squares or simply blank by such printers.

One of the several possible solutions to such printing problems is to install one of several Chinese Word Processors (e.g., NJ Star, RichWin, etc.) that have the necessary printer driver to print Chinese text properly. You need to open up such Chinese word processor when you need to print Chinese text on your printer.

Of course, these Chinese word processors also enable you to input Chinese characters into the PC or to read Chinese text in your received Chinese files. (See Sections 8 and 9 for more details.)

3.4. MS Chinese Language Input Method Editor (IME)

In addition to several available Chinese Word processors, MS Chinese language Input Method Editor (IME) provides several methods (e.g., Zhuyin, Pinyin, and ChangJei) for you to input Chinese characters into the PC. The procedure to active MS Chinese language IME on your PC is described in Section 9.3.

4. Challenge and Problems of Handling Chinese E-Mails

4.1. Corruption and Destruction of Chinese E-Mails

Many e-mail systems and Internet processors corrupt and destroy Chinese text such that all Chinese characters become garbage at the receiving end. Handling, especially sending, e-mails with Chinese text safely from MS English Windows through Internet and various e-mail systems is tricky and is substantially more challenging than sending English e-mails. Appendix A provides detailed description for the reasons for such corruption and destruction of Chinese e-mails due to the use of 2-byte and 4-byte direct encoding of tens of thousands of Chinese characters in the current Chinese computer coding systems. 

4.2. Other Mismatch and Incompatibility Problems

(a) Furthermore, many different and incompatible encoding systems (e.g., Unicode, GB Code, Big-5 Code, Eten Code, HZ code, etc.) are being used in the computer industry to encode Chinese characters. The incompatibility among these encoding systems can give users a lot of troubles. 

(b) Another source of problems comes from incompatibility between different Chinese text fonts and different Symbol fonts for the Chinese characters.

4.3. General Overview on Handing Chinese E-Mails and Chinese Files

4.3.1. Hopeful Situations

When the Chinese characters in the received e-mail appear as some special symbols or blank square boxes, (but not question marks), they usually mean that the correct information have been received, but there is a mismatch in the incompatible internal encoding systems or the incompatible fonts for the Chinese characters used by the e-mail sender and by the e-mail recipient. Such cases represent challenges on the experience, skills and resources available to the recipient to try various possible combinations of different encoding systems and fonts in the PC to find the correct combination that will match those of the e-mail sender so that the Chinese characters will become readable and meaningful. The procedures to try these changes in encoding systems or in fonts are described in details in the following sections 4 to 10 in this article.

Furthermore, the following website:

www.mandarintools.com/index.html  
 is available to repair corrupted Chinese E-Mails. Paste the corrupted text into a field on this website and press “Fix“ to restore it to original.
4.3.2. Dead-End Situation

However, our experience indicates that if all the Chinese characters in the received e-mail become question marks (i.e., ???), the information has been destroyed by the e-mail system and the Internet processors by the mechanism described in Appendix A. It is impossible for the recipient to recover the correct Chinese characters by changing encoding system or by changing font because this is a destruction problem and not a mismatch problem.

5. Reading Received Chinese E-Mails

5.1. Using MS Outlook and Outlook Express E-Mail Systems

5.1.1. Easy Cases

Usually, I use MS Outlook (Version 2000 SR-1) e-mail system to handle e-mails. After opening up a received Chinese e-mail in Outlook to read, the Chinese characters may look like some strange symbols. However, if we pull down the "View" menu from the Tool Bar at the top and click on "Encoding", it will provide a list of many languages (such as Arabic, Chinese, Greek, Hebrew, Japanese, Thai, Turkish, Western Europe, etc.) for us to choose. If we choose Chinese (Traditional) or Chinese (Simplified), then we can read Chinese e-mails under the MS English Windows 98 environment on the computer monitor screen.

The procedure to handle Chinese e-mails on Outlook Express is the same as that for Outlook.

5.1.2. Square Boxes

The method described in Section 5.1.1 works on many Chinese e-mails that I receive from Asia. However, this method does not work on some Chinese e-mails and the Chinese characters show up as blank square boxes on the monitor screen even after I clicked on View menu and selected the Chinese encoding.

Sometimes, if I highlight the entire file and change the font to MingLiU font, then the blank square boxes become readable Chinese text.

MingLiU font means Ming Light (細明體) Unicode font and is the default font often used by Microsoft for traditional Chinese characters.

Sometimes, if I hit the “Forward” or “Reply” button on Outlook E-Mail system, the blank square boxes in the original incoming Chinese e-mail all become readable Chinese characters.

5.1.3. Need Help From an Add-On Chinese Word Processor

In the cases when the Chinese characters in the received e-mail appear as blank square boxes, if I open up an add-on Chinese word processor, such as RichWin, in my PC, then all the Chinese characters in the received e-mail become readable Chinese characters.

5.2. Using Yahoo Web E-Mail System

Occasionally, I access my e-mails in my Yahoo “web” e-mail account by: (1) using MS Internet Explorer (IE) to access Yahoo web site, (2) then I log in and access e-mails in my Yahoo web e-mail Inbox on the Yahoo web site. When I open up a received Chinese e-mail, sometimes the Chinese characters may look like strange symbols. Dr. Tien-Lin Ho provides the following procedure to overcome the strange symbol problem: 

Click on the right button of your mouse that opens up a menu. Click on "Encoding", it will provide a list of many languages for me to choose. If I choose Chinese (Traditional) or Chinese (Simplified), then I can read received Chinese e-mails properly on the Yahoo web e-mail system. 
5.2.1. Forwarding or Reply

A friend reported a strange behavior of Yahoo web mail in handling Chinese e-mails with MS Windows 98 and MS IE V 5 similar to my experience on MS Outlook E-Mail system described in Section 5.1.2. He could not read the Chinese characters in the received e-mail. However, when he hit the “Reply” button to response to the original Chinese e-mail, the Chinese characters in the lower box of the original Chinese e-mail to him all became fine, clear and readable. 

5.3. Using AOL E-Mail System

There are two different methods to access AOL e-mails. One method is to use MS IE to access AOL web e-mail similar to accessing Yahoo web e-mails described in Section 5.2. In this web-mail method, again, I can pull down the "View" menu from the Tool Bar at the top of MS IE and click on "Encoding", it will provide a list of many languages for me to choose. If I choose Chinese (Traditional) or Chinese (Simplified), then I can read Chinese e-mails properly on AOL web e-mail system.

Another method is to click on the right button of the mouse similar to the procedure described by Dr. Tien-Lin Ho in Section 5.2 for Yahoo web e-mail system. 

The second method to access AOL e-mail is to double click on the AOL Icon on the desktop of the PC screen. This will take me through either a modem dial-up process on the phone-line or a cable modem process to reach AOL Log-In Window. This method works well for English e-mails. However, this method does not invoke MS Internet Explorer (IE) such that I cannot pull down the “View” menu of MS IE to choose Chinese language. Therefore, all the Chinese characters are corrupted and look like strange symbols in this method! In other words, this method is useless for accessing Chinese e-mails.

However, Dr. Yau-Chau Chin uses the second method to access AOL with a twist. After he reaches AOL, he opens the MS IE, then access AOL Web E-mail system through MS IE. Since MS IE is invoked, then he can pull down the View menu and click on Encoding for Chinese language to read received Chinese e-mails.

5.4 Handling Strings of Computer Internal Codes in Received E-Mail

Sometimes when we open up an e-mail from Asia, we see many pages of strings of computer internal codes that look like:

&#65367;&#65353;&#65363;
which make no sense to us at all. 

Dr. Gwo-Ming Jan indicates that we can read such information on Internet browser if we go through a procedure to convert such strange e-mail file into the web page format (i.e., HTML file). The conversion procedure for MS English Windows 98 SE is the following:

A. In MS Outlook E-Mail system, pull down the file menu and save the strange e-mail file as a “text only” file (i.e., xxx.txt) in a file folder, such as TEMP file folder, in your hard disk. 

B. Open the MS English Word

C. Pull down the file menu and click “Open”

D. In the “Open” dialog Window, make sure that the “files of type” at the bottom is “All Files” so that you can find and open the text file (i.e., xxx.txt) that you want.

E. Open this xxx.txt text file under MS Word.

F. In MS English Word, save this file again but as a “web page” file (i.e., a HTML document) in the TEMP file folder.

G. Open MS Windows Explorer that shows this HTML file in TEMP file folder in your hard disk.

H. Use your mouse to double click on the file name of this web page file (i.e., HTML file) 

I. Then you can read the information on the MS Internet Explorer. 

6. Surfing Chinese Internet Web Sites

6.1. Using MS IE

I use MS Internet Explorer (Version 6.0) for surfing Internet web sites. In MS Internet Explorer, if we pull down the “View” menu from the Tool Bar at the top and click on “Encoding”, it will provide a list of many languages (such as Arabic, Chinese, Greek, Hebrew, Japanese, Thai, Turkish, Western Europe, etc.) for us to choose. If we choose Chinese (Traditional) or Chinese (Simplified), then we can read Internet web site information in Chinese language under the MS English Windows 98 environment on the computer monitor screen.

On the other hand, if you are using a very old version of Internet Explorer with an old version of Microsoft Windows that have no foreign language capability, you will not be able to see Chinese text on Chinese websites. If this is the problem, you may pursue the following two possible solutions:

a. You may access Microsoft product upgrade website for free download of language support software package to add Chinese language capability to your PC as described in Section 3, or

b. You may upgrade (i.e., replace) your old version of Internet Explorer by new version (e.g., 6.0) of Internet Explorer that has the foreign language capability.

6.2. Using Netscape Navigator

Newer versions (e.g., 4.7) of Netscape web browser also has multi-lingual capability to read Chinese text on the website.

7. Reading Chinese Word Documents

7.1. Easy Cases

When we open a Chinese MS Word document under the MS English Windows 98 environment and MS English Word-2000 to read, if we pull down the "Tool" menu of the tool bar at the top of MS English Word and click on "Language", then click on "Set Language", it will show a very large list of languages (such as Arabic, Chinese, English, French, German, Greek, Hebrew, Japanese, Thai, Turkish, Western Europe, etc.) for us to choose. If we choose Chinese language, then we can read the Chinese word documents on the computer monitor screen.

The method described above using the Chinese Language capability of MS English Windows and MS English Word on my Dell PCs works well on some Chinese word documents generated from Microsoft Chinese Windows and Microsoft Chinese Word commonly used in Asia. 

7.2. Needs Help from Add-On Chinese Word Processor

However, some MS Chinese Word documents from Asia cannot be handled properly by the method described in Section 7.1. When I encounter such problems, I open up an add-on Chinese word processor, such as RichWin (See Section 9.1), running under MS English Windows. Then I can read the MS Chinese Word documents from Asia properly.

7.3. File Name with Chinese Characters and Their Troubles

MS English Windows recognizes only those files where file names contain only 1-byte encoded English letters, but NOT 2-byte or 4-byte encoded Chinese characters. Therefore, if the file names of the Chinese files from Asia contain Chinese character(s), our PCs with MS English Windows cannot recognize such files names, cannot find such files and, therefore, cannot open up such files. 

A solution for this problem used by Dr. Cheng-Chi Kao is the following:

a. Save the file in a temporary file folder and give it a temporary English file name such as aaa.doc, (For example if the file with Chinese characters file name comes as an attached file in an e-mail into your MS Outlook e-mail system, you can use Right button of the mouse to click on the file name, then click on “Save As”, then specify the temporary file folder in your hard disk and give the temporary English file name to save the file with the temporary English file name into your hard disk.)

b. Open the file with your temporary assigned English file name to read its content,

c. If you want to keep this file, you then re-name the file with a new English file name that reflects its content. Then move this new file into the appropriate file folder.

Another method to deal with this problem is to open up a suitable add-on Chinese word processor, such as RichWin. MS English Windows plus the help of such add-on Chinese word processor then can recognize and handle file names that contain Chinese characters. 

The last resort is to contact the senders of the e-mails in Asia and ask them to change the file name to eliminate the Chinese characters in the file name and to re-send the new file with English file name to me so that my system can recognize and handle the file. 

Sometimes, I receive a physical diskette with Chinese files that have Chinese characters in their file names. Again, MS English Windows does not recognize such file names with Chinese characters and cannot open up such files. A solution to this problem is to open up a suitable add-on Chinese word processor such as RichWin, which enables me to use Windows Explorer to see the Chinese characters in the file names. With RichWin and Windows Explorer open, I can change the file names of these files to new file names with only English letters. Then I can open and read these files with English file names.

7.4. Pile-Up Problem with PMingLiU Chinese Font

Sometimes, the Chinese documents in the format of Microsoft Word generated from Microsoft Chinese Windows in Asia cannot be read properly under Microsoft English Windows because of certain Chinese fonts used in the original Chinese documents. For example, if the original Chinese Word file uses the PMingLiU font, then when such Word file is opened up under the Microsoft English Windows, all the Chinese characters on the same horizontal line are piled up at the same spot at the left edge of the line (and nothing else on the remaining portion of the line) such that the file is unreadable. 

Two solutions to such problem are: (1) to highlight the entire Word file and to change the Chinese font from PMingLiU to MingLiU, then all Chinese characters are spread out properly so that the Chinese file becomes readable, and (2) open up an add on Chinese word processor, such as RichWin, then the piled up Chinese file becomes readable even if it is using PMingLiU font. 

MingLiU font means Ming Light (細明體) Unicode font and is the default font used by Microsoft for traditional Chinese characters.

PMingLiU is supposed to be a newer version (新細明體) of Chinese font for a much larger set (> 20,000) of traditional Chinese characters. 

I do not understand why PMingLiU font, and some other Chinese fonts such as 標楷體 used by Chinese Windows, causes the piled up problem of Chinese characters described above when such Chinese files are opened up under the English Windows environment. I also do not understand why such problems disappear when a Chinese word processor, such as RichWin, is opened up under the English Windows.
7.5. Using Netscape Navigator

Dr. Keith Chang used Netscape 4.7 Web e-mail to open attachment with Chinese text and there was no problem with the Chinese text in it. Evidently, Netscape 4.7 has the required language capabilities.  He suggests the following procedure: 

While you are on your Netscape Web e-mail, click Edit/Preferences/Appearances/Fonts, and then check the item: "Use document-specified fonts, including Dynamic Fonts" to handle Chinese text.

On the other hand, Dr. C. P. Wu was using an older version of Netscape that lacks such foreign language capabilities.
8. Printing Chinese E-Mails and Chinese Documents

8.1. Happy Printing of Chinese Files on HP and Cannon Printers

Several of my friends are using some versions of HP printers (e.g., HP IIIp printer, HP Deskjet 970Cxi printer, HP870Cxi printer) and Cannon printers and they can print the Chinese e-mails and Chinese documents properly under MS English Windows without the help of a separate Add-On Chinese Word Processor. It appears that the printer drivers of these HP printers and Cannon printers in USA support printing of not only English files but also files of other non-alphabet based foreign languages including Chinese language. 

8.2. Printing Problem and Solution on Brother MFC Printer

However, I am using Brother MFC (Multiple Function Center) printers (model 6550MC, and model 4350) and if I try to print the Chinese e-mails or Chinese word documents from Asia on my PC under MS English Windows 98 or 95, each Chinese character is printed as a blank square box on the paper from my Brother MFC printers! 

Microsoft acknowledges this printing problem and indicates that this problem occurs because some printer drivers do not provide support for characters of non-alphabet based foreign language that use 2-byte (16-bit) Unicode encoding system ( http://www.unicode.org/ ). More detailed explanation by Microsoft can be found at the following Microsoft web site:

http://support.microsoft.com/support/kb/articles/Q212/3/80.ASP 

with article title of “WD-2000: Characters Appear as Square Boxes in Printed Document.”
This web site also provides a list of 15 printer drivers that have such printing problems of blank square boxes. 

Notice that my problem of printing Chinese files from Asia on Brother MFC printers is NOT due to the lack of Chinese fonts in my Dell PC or Compaq PC because I can read and view these Chinese files on the monitor screen without problem. I can even highlight the Chinese text and pull down the “Format” menu to change the Chinese font or the font size of the Chinese text displayed on the screen. Therefore, the problem is in the printer driver for the Brother MFC printers.

I sent an e-mail to technical support of Brother International Corporation (mallmaster@brother.com ) for help and asked them if they have newer version of Brother printer driver that can print Chinese text in addition to English text. The response e-mail from Brother suggested that I use the printer driver of HP Laserjet IIp for printing Chinese characters on Brother MFC printers. I then used the “Add Printer” wizard located in the “Printers” folder in the Control Panel to load and to install the HP Laserjet IIp printer driver from my CD-ROM of MS Windows 98 SE installation disk. After such installation, indeed I can print Chinese characters properly on the Brother MFC printers with HP Laserjet IIp printer driver!

Notice that the MS web site:

http://support.microsoft.com/support/kb/articles/Q212/3/80.ASP 

indicates that many other printers, in addition to the Brother MFC printers, have such problems of printing blank square boxes.

8.3. Use Special Capability of Some Printers with Print True Type Fonts as Graphics 

Some printers have the capability for printing True Type Fonts as Graphics. One can use the following procedure to overcome this blank-square-box printing problem with such printers under English Windows 98. The procedure to activate this printing capability on such printers is:

A. Pull down the “File” menu

B. Click on “Print”

C. Click on “Properties” on the printer dialog windows

D. Click on “Font” tab

E. Click on “Print True Type Fonts as Graphics”

Some printers (e.g., HP LaserJet 4 Series) have such capability, but many other printers do not have this capability.

8.3.1 More Serious and Crazy Printing Problems

In printing a Chinese text file under MS English Windows, some printers go crazy and print just one strange symbol at the upper left corner of the printing paper, then skip to the next page to do the same thing. These printers keep going this crazy way to waste a lot of printer papers without printing any thing meaningful. Furthermore, one cannot stop such crazy printer behavior by any of the printer control commands under the MS English Windows. In desperation, one is forced to turn off the power switch of the printer or to pull out the power plug of the printer. 

The procedures A, B, C, D, and E described in Section 8.3 solve such printing problems on some printers (e.g., HP-Laserjet 4).  

8.4 Use Add-On Chinese Word Processors To Facilitate Printing

8.4.1. Happy Experience With RichWin

The Brother MFC printer lacks (1) the capability for printing True Type Fonts as Graphics and (2) the capability to print Chinese characters as described in Section 8.2. The second way that I can print the Chinese e-mails or Chinese word documents that I receive from Asia on the Brother MFC printers is to open up a suitable Add-On Chinese word processor that runs under the MS English Windows 98 environment. The Chinese word processor that I am using recently is RichWin. Information on RichWin Chinese word processor can be found at the web site: 

http://www.asiazest.com/asiazest/jsp/index.jsp  or 

http://richwin.sina.com.cn/ . 

Such add-on Chinese word processor provides the suitable printer driver so that my Brother MFC printers can print the Chinese characters properly. The internal computer coding system for Chinese language in RichWin works very well with the Chinese e-mails and Chinese computer files that I receive from Taiwan and from mainland China. RichWin enables me to print these Chinese e-mails and Chinese computer files from Asia on Brother MFC printers properly. It appears to me that RichWin and the Chinese computer files from Asia are all using the same newer Unicode system (http://www.unicode.org/ ) standard for Chinese language in the computer and are compatible with each other.

8.5. Second Level of Printing Problems.

After we overcome the problem of blank square box printing problem, we may still run into the second level of printing problems in that the format of the printed Chinese file may not be exactly the same as the original, especially if the file has tables, or figures or if the recipient is using an older version of MS Word (e.g., Word-97). The font size of the Chinese characters may not be correct such that adjacent characters may run into each other with insufficient space between the adjacent characters.

9. Input Chinese Characters into PC and E-Mail Running MS English Windows

9.1 Using Add-On Chinese Word Processors

Several add-On Chinese word processors are available for inputting Chinese characters into the PC running MS English Windows. Some examples are: 

RichWin (http://www.asiazest.com/asiazest/jsp/index.jsp  ),

NJ Star (http://www.njstar.com/ ), 

UnionWay  (http://www.unionway.com/servlet/Node?Node=1 ), and

Chinese Star (http://www.suntendy.com/ ) .

The supported input methods may include Zhuyin, Pinyin, ChangJei, English-To-Chinese, Hong-Kong (Cantonese) method, Telegraph, etc. 

I usually use the Zhuyin method (i.e., Bo Po Mo Fo). RichWin provides a software defined keyboard display of the phonetic spelling symbols (including the four tone marks) of Zhuyin method on the monitor screen. By using the mouse to click the correct sequence of the phonetic spelling symbols of the Zhuyin system on the screen, then staring very hard on one or more long lists of homotones that pronounced exactly the same (but with different meanings), and picking the correct Chinese character that I want from these long lists, I can input the Chinese characters into the PC at a very slow pace relative to my regular pace of typing English words.

A control panel in RichWin offers several options for different layouts of the Zhuyin spelling symbols on the soft keyboard. You need to open this control panel and to select the keyboard layout option that is most familiar to you to facilitate your speed of Chinese input process. Otherwise, you will be spending a lot of time staring at the unfamiliar soft keyboard layout searching for each spelling symbol that you want to click.

The English-To-Chinese input method is also very useful to many Chinese-Americans. In this method, you just type an English word (e.g., Star) on the regular English keyboard, the RichWin software will translate the English word into the corresponding Chinese character (e.g., 星 ) and input it into the PC.

9.2 Using Writing Pad for Chinese Character Input

Dr. Edward Chien in California and Dr. May Lee in New Jersey have been using a writing pad from PenPower Technology Ltd. (http://www.penpower.com.tw  or  http://www.asiazest.com/asiazest/jsp/index.jsp ) to input Chinese characters into the PC by handwriting on the pad instead of using the keyboard. The PenPower writing pad (蒙恬筆) has a lot of intelligence and adaptive learning capability to recognize your handwritten Chinese characters. Dr. Edward Chien has experience in trying out several different kinds of writing pad for Chinese computer input. Based on his experience, Dr. Edward Chien recommends this method and PenPower highly. Dr, May Lee provides the following additional information on using PenPower on Microsoft Windows XP:

After the installation of PenPower, the Chinese mode of Windows XP needs to be activated by:

1. Click the icon En and change it to Chinese CH.

2. Click the Start menu, then click on the PenPower icon.
3. Open the program you prepare to write in, e.g. Word.
4. Start writing on the writing Pad with the stylus, the Chinese character will appear on the curser. If it is not the correct one, other possible choices are available for you to click on, or press the left button of the pad continuously until your choice appears.
9.3 Using MS Input Method Editor

Dr. Keith Chang in Canada introduced me to a lot of the information in Section 9.3 regarding Input Chinese characters using Input Method Editor (IME) under MS English Windows environment in PC without the need for using other Add-On Chinese word processors described in Section 9.1. 

Some more information on MS IME can be found at the following MS website:

http://www.microsoft.com/windows/ie/downloads/recommended/ime/default.asp 

Furthermore, one can get some more information and MS instruction on MS IME on MS Windows 98 SE by clicking on “Help” on the menu bar on top of MS Word-2000, then click on “Microsoft Word Help” which will pop up an yellow-colored Office Assistance dialog box that will ask you what would you like to do? With a blank space for you to respond. You type in Input Method Editor in the response blank space and click Search. The Search results in a list of several items related to the Input Method Editor for you to pick. You then click on the item of interest to you to read.

Another method to get Microsoft detailed online instructions on IME is described in Section 9.3.1.3.2.

A tutorial for IME is available at the following website:

http://www.andante.org/ime.html 

According to the experience of Dr. Keith Chang, MS English Windows 2000 has built-in very powerful capabilities to handle many different languages in the world, including Chinese (Traditional) and Chinese (Simplified). English Windows 98 also has some limited capabilities to handle many languages including Chinese.

9.3.1 IME in MS English Windows 98

The foreign language capability in MS English Windows 98 is a much stripped-down version as compared to that in MS English Windows 2000. In English Windows 98, the Chinese language, and other languages, are available only in Outlook and MS Word (Office 2000 Edition) but not in PowerPoint (a big drawback!), neither in Excel. Even then, a number of functionalities are not there. For example, I cannot print the Chinese characters on my Brother MFC printer (unless I activate other Add-On Chinese word processors, such as RichWin, or use the HP printer driver.) Furthermore, you cannot switch between Traditional and Simplified at all (which you can do by just one click on the status bar under Windows 2000). 
9.3.1.1. – Download, Installation and Activation of IME With MS Windows 98 

For MS English Windows 95 and 98, you access the following MS web site to download and to install Global Input Method Editor (IME) into your PC:

(1) http://www.microsoft.com/msdownload/iebuild/ime5_win32/en/ime5_win32.htm 

Once on this website, you select MS Global IME for Chinese (Traditional or Simplified) with Language Pack, then click “Next” which will initiate the download and installation of the Chinese IME into your PC. 

After you re-start your PC to complete the installation process, you then do the steps in the next Section to activate the Chinese IME on your keyboard and your PC.

9.3.1.2. Activate IME on Your Keyboard

The procedure to activate the foreign language IME on your PC keyboard with MS English Windows 98 (SE) is:

A. Click on “Start” at the left lower corner of your monitor screen

B. Click on “Setting”

C. Click on “Control Panel”

D. Click on “Keyboard”

E. Click on “Language” tab on the top of the Keyboard Properties dialog box

F. Click on “Add” in the middle of the Keyboard Properties dialog box (to add another language) 

G. A long list of foreign languages will show up for you to choose

H. You choose the language (e.g., Chinese-Traditional) you want

I. Click “OK”

J. Make sure that the check box for “Enable Indicator on Taskbar” is checked

K. Click on “Apply” at the lower right corner of the Keyboard Properties dialog box

L. At this point, a dialog box will pop up and ask you to insert your MS CD-ROM of MS Windows 98 (Second Edition) so that the PC can copy the relevant software from the CD into the hard disk in your PC.

M. You insert the CD and click “OK” for the PC to copy the software from the CD

N. Repeat Steps F to K to select any other language (e.g., Chinese-Simplified) you want

9.3.1.3. Using Chinese IME on Windows 98

After you finish these steps to activate IME on your keyboard, a blue color language icon (e.g., En in white color with blue background) will appear on the right side of the taskbar at the bottom of your monitor screen for you to use. En represents English in the default status. 

In MS Windows 98 SE, if you click on the blue En icon without opening up a suitable MS Office application program, you see “English” as the only language that you can use. On the other hand, if you open up MS Word 2000 application program, or MS Outlook, or MS Outlook Express or MS Internet Explorer and then click on this blue En icon, it will show a menu of English and other languages (such as Chinese Simplified IME, 　Chinese Traditional ChangJie IME and Chinese Traditional IME) that you have activated through Steps A to M in Section 9.3.1.2. 

9.3.1.3.1 Chinese Simplified IME
If you click on Chinese (Simplified) IME, two things will happen: (1) the Blue En icon changes to a PY icon for Pinyin IME that uses the regular English keyboard for Chinese character input, and (2) a small 4-block floating toolbar with the Chinese character中in the left block and a Chinese character拼on the right block will show up on the lower left corner of your screen. 

9.3.1.3.2 MS Instruction on Using Chinese IME on Windows 98
If you use the right button of the mouse to click on each of these four icons on the 4-block floating toolbar, a menu with several options will pop up for you to choose. The option on the top of this pop-up menu is the detailed instructions from Microsoft on how to use MS IME. You may spend sometime here to click on various options to learn about various available functions in MS IME.

For Chinese (Simplified) IME, you just type the regular English alphabetic letters on the regular English keyboard to input Chinese characters if you are familiar with the Pinyin spellings for Chinese characters. Most Chinese characters have many homotones that have exact the same Pinyin spelling. Therefore, after you finish typing the Pinyin spelling for a Chinese character on the standard English keyboard, IME will pop up a list of homotones for you to stare at and to choose. By clicking on the desired character, that character goes into the document that you are creating. According to the experience of Dr. Keith Chang, Pinyin IME is the quickest and simplest way for him to input Chinese characters into the PC. 

For people who are familiar with Zhuyin system to spell Chinese character and want to learn Pinyin Spelling system, mapping table between Zhuyin symbols and their corresponding English alphabetic letters used in the Pinyin system is available on pages 667 and 668 in:

Xinhua Zidian (新华字典)，2001年, 大字本，附四角号码检字表, 商务印书馆, 北京.
This dictionary is also quite useful in learning Pinyin spelling for Chinese characters.

9.3.1.3.3 Chinese Traditional IME
For Chinese (Traditional) IME, English Windows 98 offers two IMEs: (1) Zhuyin IME, and (2) ChangJie IME (i.e., character decomposition method). 

If you click on Chinese Traditional IME on this menu, a small 2-block floating toolbar with the first Zhuyin symbol of “Bo” in the left block and a Chinese character of “half” on the right block will show up on the lower left corner of your screen. If you use the right button on your mouse to click on the “Bo” Icon or the “half” Icon, a menu of (i) software defined keyboard for Zhuyin symbols, (ii) soft keyboard for punctuation symbols, (3) MS Instructions on how to use MS IME, and (4) keyboard layout options, will show up for you to choose. If you choose the Zhuyin soft keyboard, a software defined keyboard with Zhuyin symbols will pop up on the lower right side of the screen for you to use the Zhuyin IME to input the traditional Chinese characters into the PC. 

Zhuyin spellings for Chinese characters can be found in several Chinese dictionaries, such as the Section on “注音符號檢字表” in 學生字典 or 同音字典.
9.3.2. IME in MS English Windows 2000

On the other hand, the instruction for such procedure for MS English Windows 2000 can be found in the following two places:

(1) http://www.chinesecomputing.com/ Newsletter- Feb. 2001, and

(2) Microsoft web site: 
http://support.microsoft.com/support/kb/articles/q216/5/96.asp  
Entitled "WD2000: How to Install and Use the Input Method Editor from the Office MultiLanguage Pack" provides instructions on how to install and use IME for Word 2000.
(I do not have MS English Windows 2000 installed on my PC. Therefore, I am not able to describe in details the procedure to activate the IMEs of foreign languages on the PC using Windows 2000.) 

9.3.2.1. IME in MS English Windows 2000

According to Dr. Keith Chang, MS English Windows 2000 Professional has built-in capability to handle practically all languages in the world. It has such foreign language capability not only in Outlook and MS Word, but also in MS PowerPoint, MS Excel and other Office 2000 programs. It enables users to input foreign language characters. Furthermore, the user is free to switch among several languages by just one click. You can enter any and multiple languages within the same document.
Dr. Andy Soong has been using MS Windows 2000 and used to have the Chinese IME module automatically opened whenever he open his PC and the IME icon sits at the lower right corner. The IME icon is a blue square with a white EN on it. Now, the IME icon is not there. Dr. Andy Soong asked me about how to activate this IME module and bring the IME icon back.

Dr. Keith Chang provides the following response to Andy’s question:

a) Go to Start/Settings/Control Panel, and then click on Keyboard.  Keyboard Properties window appears.

b) Click on the center tab “Input Locale” and the “Input Languages and Methods” window appears.

c) Click “Change” and “Text Services” window appears.

d) On the “Preferences” box at the bottom, click “Language Bar”.  “Language Bar Settings” window appears.

e) Check “Show the language bar on the desk top”.

f) Click OK …to close all the open windows. 

That should do it.  Note, however, the above is based on MS Windows 2000.  It would be slightly different with other versions of Windows, but the basic idea is the same.

9.4. Open Only One Chinese Text Generator At A Time

There are several different ways and different add-on Chinese word processors available for Chinese computer users to generate Chinese text for sending Chinese e-mail as described in Sections 8.1, 8.2 and 8.3. However, to generate Chinese text, one should open only one Chinese text generation software program and close out all other Chinese word processor programs in the PC. 

Otherwise, if two or more different kinds of Chinese word processor programs are open simultaneously in the same PC, one does not really know which one is generating the Chinese text and can cause some unexpected problems, especially if one of the several opened Chinese word processor programs is TwinBridge of Version 4.98 or older. For example, you may think that you are using MS Windows IME to generate the Chinese text while the Chinese text is being generated from TwinBridge in your PC, then many recipients will not be able to read your Chinese e-mails if they do not have TwinBridge program in their PCs or if their TwinBridge programs are not open even if they have TwinBridge program in their PCs. Such problems are caused by the incompatibility in internal coding for Chinese characters between old versions of TwinBridge vs. many other Chinese platforms including MS Chinese platform.

10. Sending Chinese E-Mails

10.1. Sending Chinese E-Mails by MS Outlook E-Mail System

By using the methods and resources described in Section 9, you can generate Chinese text that can be sent by e-mail to many recipients. As described in Section 4 that sending Chinese e-mails through Internet and various e-mail systems is tricky and very challenging. 

10.2. Indirect Methods to Send Chinese E-Mail

One method to avoid the corruption and destruction problems of Chinese e-mail is to type the Chinese text in a Microsoft Word file, then send the Word file as an attachment to a simple English e-mail. This works well for most cases.

When the main message in Chinese text is wrapped up in such attached file, there should be some English text in the subject line and in the main body of the e-mail to let the recipient(s) know what is in the attached file. Otherwise, the recipient may be nervous and hesitant to open such “strange e-mail” with no subject line and no main body but only an attached file. It may looks like a computer virus file to the e-mail recipient(s).

However, some recipients may not have their PC equipped with suitable Chinese language support or with Microsoft Word and may not be able to handle the Word file. 

Another method to avoid the corruption and destruction problem is to convert the Chinese Word file into an Adobe PDF (Portable Document Format) file, then send the Adobe PDF file as an attachment to a simple English e-mail. The Adobe PDF Reader is available for free download from the Adobe website at:

http://www.adobe.com/ 

With such free download and installation of the Adobe PDF Reader, practically everybody can open and read PDF files.

In addition to the use of the format of MS Word or Adobe PDF for the attached Chinese text, one may also use HTML format, RTF (Rich Text Format), or GIF (picture format) for the attached Chinese text. There are different advantages and disadvantages among these formats depending on the software capabilities of the senders and the recipients to handle these formats. 

If we are sending the Chinese text in the format of MS Word, or HTML or RTF as an attachment of an e-mails to people in Asia, Dr. Tau-Yuan Chang suggests that setting the Chinese font to MingLiU is the best approach to make sure that the recipients in Asia can read the file. MingLiU is the default font used by Microsoft for traditional Chinese characters. Ming stands for 明體 font, Li stands for Light (細) and U stands for international Unicode standard. Therefore, MingLiU stands for 細明體 Unicode font for traditional Chinese characters.

10.3. Chinese E-Mail and HTML Mode of E-Mail

However, both Word file attachment and Adobe PDF file attachment are indirect way of sending Chinese e-mail. If you want a more direct way of sending Chinese e-mail successfully, then you need to use the HTML (HyperText Markup Language) mode of e-mail system.

The Microsoft instruction (online Help) for using Microsoft IME (Input Method Editor) to generate Chinese text and for sending Chinese e-mail is:

Outlook Mail Message Format

The mail message format must be in HTML to use the Global IME. Please find the Tools menu, select Options, then the Mail Format tab. Change your Message Format from Microsoft Outlook Rich Text to HTML.
According to the Microsoft Instructions, we must use HTML mode of the E-Mail system to be able to send Chinese text safely through Internet and various e-mail systems without being corrupted.

My experience indicates that if we use the “plain text” mode, instead of the HTML mode, the Chinese e-mails often become garbage at the receiving end. 

To set up the HTML mode on my Microsoft Outlook E-Mail system, I use the following procedure (I), (II), and (III) with Note (I), Note (II) and Note (III):

(I) Use HTML Message Format - To set this message format, I open up the MS Outlook (but before I open up any e-mail message or before I open up a blank new mail message page for me to enter new message), pull down the “Tools” menu, click on “Options”, then click on “Mail Format” tab, then in “Send in this message format” options, select the HTML option. Other modes of message format do not work for Chinese e-mails as explained in Note- (I).

(II) Use “New” Mail Message - Open up a blank new e-mail message page for me to enter the e-mail message containing Chinese text by pulling down the “Actions” menu and click on “New Mail Message”.  Then enter my Chinese and English mixed e-mail message. The reason for Step (II) is given in the following Note- (II).

(III) Select Chinese Language for Outgoing E-Mail – After I completed entering the e-mail text including the Chinese text but before I hit the “send” button to send the outgoing Chinese e-mail, I must select Chinese Language for the outgoing Chinese e-mail so that the Chinese characters are sent properly through the e-mail systems and Internet to the recipients. The procedure is as follows:  Pull down the “Tools” menu, click on “Language”, then click on “Set Language”, then select the “Chinese (Traditional)” or “Chinese (Simplified)”. 

Note (I) - Troubles with Other Modes - If I use other modes such as “Plain Text” mode or “Microsoft Outlook Rich Text” mode of the e-mail system, all the Chinese characters in the e-mail get corrupted in the e-mail systems and become garbage at the receiving end. I have the three e-mail addresses on Monmouth Internet ISP, Yahoo and America Online (AOL) respectively for me to do experiments with myself on sending and receiving Chinese e-mails. I have been doing experiments with myself and with a few of my friends by sending Chinese e-mails from each one of my e-mail addresses to all three of my e-mail addresses and to some friends using different message modes of e-mails to see what the e-mail systems and the Internet will do to the Chinese text. These self experiments and the experience from other friends indicate that “HTML” mode is the only reliable mode that can survive all the processing in various e-mail systems and Internet consistently. Other modes are very shaky in the sense that the Chinese text may or may not get through successfully.

Note (II) - Troubles with Reply and Forwarding - I cannot use “Reply” to or “Forward” an incoming e-mail to send my e-mail with Chinese text if the incoming e-mail is not in HTML mode. This is because the format of the incoming e-mail controls the message format of my reply message or my forwarded message and it does not honor my settings of HTML message format in Step (I) and does not honor my Chinese language selection in step (III). When my settings of HTML and Chinese language are not honored in my reply or forwarded message, all the Chinese characters in my reply or forwarded message become corrupted as question marks at the receiving end. When all the Chinese characters become question marks in the e-mail message, too much information is lost already such that the recipient can NOT be restore the correct Chinese text even if the recipient pulls down the “View” menu and sets the encoding to Chinese language.

Note (III) – The Microsoft instruction (online Help) for using IME and for sending Chinese E-Mail is:

Sending Mail

Messages must be "tagged" correctly with the appropriate (international) character set (standard) so the receiving e-mail applications know how to display the text.

1. Open or create the message you want to send.

2. Find the Format menu and select Encoding. 

3. Select Chinese Traditional (Big5) or Chinese Simplified.

Skipping this critical Step (III) of Microsoft Instruction may cause all the Chinese characters to become garbage at the receiving ends.

Note (IV) – It seems to me that HTML mode of e-mail systems send an e-mail in two parts: (1) Part 1 for the basic text of the e-mail, and (2) Part 2 that provides a lot information on various attributes of the text in the e-mail such as what kind of font for each word or character in the e-mail text, what font size, what color, bold or plain, etc. This set of attributes probably also contains information about what type of language, what type of encoding (e.g., 1-byte ASCII for English, or 2-byte or 4-byte non-ASCII for non-alphabetical languages such as Chinese.) It seems to me that these attribute information in Part 2 of HTML mode can tell the e-mail systems and the Internet processors on how to treat these non-ASCII encoded non-alphabetic language text properly so that they do not get corrupted and become garbage at the receiving end.

I have been using HTML mode as the default mode on my MS Outlook e-mail system since it works well for both English and Chinese e-mails. With such default setting at HTM mode, I skip step (I) in the procedure above when I want to send Chinese e-mails.

The multi-lingual capabilities in MS English Windows 2000, ME and XP are more advanced and much better than that in Windows 98. Therefore, the procedure to send Chinese e-mails in MS English Windows 2000, ME and XP may be easier and simpler than the procedure (I), (II), and (III) described above for Windows 98.

For example, Professor James C. M. Hwang is using MS English Windows ME and Outlook Express. Outlook Express in his system automatically detects the presence of non-English codes and asks him whether to "Send As Unicode" or "Send As Is." Most e-mail software can detect and decode Unicode. Therefore, he picks Unicode in sending e-mails that contain Chinese text.

Professor James Hwang uses NJStar to generate the Chinese text. Then he copy and paste the Chinese text into the e-mail message of the Outlook Express. When copying, NJ Star gives the following options for (1) Copy (which produces garbage in Outlook Express), (2) Copy as Big5 Text (繁體字), (3) Copy as GB Text (简体字), or Copy as HZ Text (简体字).
Since HTML mode is critical to protect the Chinese text from being corrupted by the e-mail systems or by the Internet processing, it is important that your e-mail systems can be set to the HTML mode. 

10.4. Setting HTML mode on Netscape E-Mail System

Dr. May Lee has been using Netscape e-mail system and provides the following procedure to set the message format to HTML on the Netscape e-mail system:

A. On Netscape Inbox screen, pull down the "Edit" menu,

B. Click “Preferences” which is the last item on the pull down menu,

C. Select "Formatting" in the "Mail & Newsgroups" folder on the left column, 

A. The Formatting window on the right hand side gives several options of message format including “HTML editing and sending modes” for you to choose,

B. In each composition of e-mail, click the icon "Option", on the Format option, select the "HTML Text only" from the dropdown menu, then this e-mail will be sent in HTML mode.
The experience of Dr. May Lee indicates that the Step (III) in Section 10.3 for Outlook E-mail system is not necessary in Netscape E-Mail system to send Chinese e-mails.

10.5. Setting HTML Mode on Other E-Mail Systems

Unlike the process in MS Outlook e-mail system that allows users to set HTML mode at an early stage of the process, some e-mail systems may give you this HTML setting capability at the tail end of the e-mail process in the sense that if you are replying to an incoming e-mail that is in HTML mode, after you hit the “Send” button to send your reply message, the e-mail system will pop up a dialog box with several options of message modes, including HTML mode, for you to choose. You can then choose the HTML mode at this tail end stage if your e-mail reply message has Chinese text.

In case if your e-mail systems do not provide a menu option for you to set them to HTML mode, there is an indirect way to try to set the HTML mode as follows. Ask one of your friends, whose e-mail system can be set to HTML mode, to send you a short test e-mail in HTML mode. After you receive this test e-mail in HTML mode, save it in your e-mail folder for future use. Each time when you want to send Chinese e-mail, you open up this test e-mail in HTML mode and hit the “Reply” button on your e-mail system to reply to this HTML test e-mail. In this way, your reply e-mail may be in the HTML mode. Then you can enter the recipients’ e-mail addresses and your Chinese message text. (At this point, you may erase the e-mail address of the originator of the HTML test e-mail and erase the original HTML test e-mail message attached to your reply e-mail if you do not want your recipients to see the original test HTML e-mail message and do not want the originator of the test HTML e-mail to receive your new Chinese e-mails.) 

Furthermore, your e-mail system must have the capability for you to select Chinese Language option for the outgoing Chinese e-mail before you hit the “Send” button to send out the Chinese e-mail. Skipping this critical step may cause all the Chinese characters to become garbage at the receiving ends.

10.6. Sending Chinese E-Mail by Yahoo Web E-Mail System and AOL E-Mail System

Both Yahoo web e-mail system and AOL e-mail system lack the critical tools for users to set the HTML mode and to select Chinese Language for the outgoing Chinese e-mails as described in critical Steps (I) and (III) in Section 10.3. Therefore, sending e-mail with Chinese text in the main body of the e-mail by Yahoo web e-mail system or by AOL e-mail system under English Windows is very shaky. It may or may not work depending on some unknown factors, which I still do not understand.

Dr. Tien-Lin Ho was able to send Chinese e-mails by using Yahoo web e-mail system under MS English Windows 98 to recipients using AT&T Worldnet E-Mail system and AOL E-Mail system. But the same procedure does not work when the recipient is using MS Outlook E-mail system. 

His procedure is the following:

a. Uses his AOL account to get on Internet, 

b. Open up MS Internet Explorer (IE) through your ISP,

c. On IE, set language to "Chinese Traditional" via the “View” menu,

d. Access Yahoo website, Log onto Yahoo web E-Mail and get to the point where E-Mail writing to begin,

e. Run NJStar Communicator,

f. Observe the NJStar Communicator menu on screen and the newly appeared NJStar icon on lower-right of screen,

g. Set the input as Chinese through the menu and set the output as "Chinese Big5" through the icon,

h. Start writing Chinese E-Mail using Pinyin method.

He then sends the Chinese e-mail successfully to another friend, Dr. Andy Soon, who is using MS Windows 98 SE, MS Outlook Express V.5 on AT&T Worldnet. Tien-Lin also sent the Chinese e-mail to himself on AOL.  Both processes were successful.

11. Having Both English and Chinese Windows on the same PC

Some of my friends have “Partition Magic” software on their PCs that enables them to install both MS English Windows and MS Chinese Windows on the same PC. In this way, they can use MS Chinese Windows and its associated Chinese application software to handle all the Chinese e-mails and Chinese files.

The experience of Dr. Edward Chien indicates the version numbers of the MS English Windows and MS Chinese Windows must NOT be the same to be able to coexist peacefully in the same PC. If the version numbers are the same, the English and the Chinese Windows in the same PC may interfere with each other.

12. Apple/Mac World

Dr. Terry Yeh is using Apple Mac PC with Mac OS 8, Mac Version of MS Office 98 application software, Yahoo e-mail system and HP870Cxi printer. Terry was able to read and print the Chinese e-mails and attached Chinese files that we sent him from our MS English Windows.

Another friend using Mac PowerBook G3 with Apple OS 9.1 was able to read the Chinese e-mail that I sent him.

For more systematic and detailed instructions on handing Chinese e-mails and Chinese documents on Macintosh PCs, please see the following website:

http://www.yale.edu/chinesemac/pages/about.html 

13. Concluding Remark

It is tricky and very treacherous to handle Chinese e-mails and Chinese documents under English Windows successfully because of many pitfalls described in this article. These problems are caused by the use of existing Chinese computer encoding systems for direct encoding of tens of thousands of Chinese characters. These problems make it difficult for Chinese people and Chinese industry to use computers and Internet as powerful tools to increase their efficiency and productivity in the modern information age. 

A solution to eliminate these problems of current Chinese computer encoding systems is the Chinese Spelling Code (CSC) invented recently by Dr. Sing Lin, Dr. David Chai and Dr. Andrew Soong (See Reference (i)). CSC will enable the users of Chinese language and Chinese industries to achieve much higher efficiency and productivity in the modern information age.

14. Some References

The following references and websites have a lot of good information on Chinese language-computer-interface systems:

(a) http://www.chinesecomputing.com/  

(b) http://www.mandarintools.com/index.html 
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(d) http://input.foruto.com/IME/BIG5/index.html 

(e) http://www.unicode.org/ 

(f) http://www.microsoft.com/windows/ie/downloads/recommended/ime/default.asp 

(g) “Impacts of Language-Computer-Interface on National Economy and Productivity,” MS PowerPoint charts presented by Dr. Sing Lin (E-Mail: sing-lin@monmouth.com ) in 2001 Emerging Information Technology Conference (2001-EITC) in Newark Airport Marriott Hotel, November 9-10, 2001 and in 2001 Annual Convention of Chinese Institute of Engineers – USA/Greater New York Chapter in Newark Airport Marriott Hotel, October 6, 2001.

(h) “Impacts of Internet Revolution on US and Japanese Economies, ” MS PowerPoint chart presentation by Dr. Sing Lin (E-Mail: sing-lin@monmouth.com )

(i) Sing Lin, David Chai and Andrew Soong, “Chinses Spelling Code” presented in 2003 Annual Convention of Chinese Institute of Engineers-Greater New York Chapter (CIE-USA/GNYC) on September 27, 2003 at Newark Airport Marriott Hotel, Newark International Airport, New Jersey. Available at the Website: www.ChineseSpellingCode.com , Contact: CSCresearch@ChineseSpellingCode.com 

Appendix A – Mechanism for Corruption and Destruction of Chinese E-Mails

The reason that many e-mail systems and Internet processors corrupt and destroy Chinese E-Mail such that all Chinese characters become garbage at the receiving end are:

(1) The 26 English alphabetic letters are encoded in the computers by the 7-bit ASCII (American Standard Code for Information Exchange) standard code. The 7-bit ASCII code has 128 possible combinations (i.e., coding space) which are more than enough to encode the 26 English alphabetic letters. One overhead leading bit is added to become the typical 8-bit byte, but the important information is in the remaining ASCII 7-bit portion of the 8-bit byte. 

(2) On the other hand, Chinese language has tens of thousands of Chinese characters, which far exceed the coding capacity (of 128) of 7-bit ASCII code. Therefore, Chinese language requires 2-byte (16-bit) encoding in the computer to have enough capacity to handle tens of thousands of Chinese characters.

(3) However, when more Chinese characters and many symbols of many other languages (e.g., Japanese, Korean, India-Hindi, Arabic, Burmese, Hebrew, Indonesian, Malay, Russian, Thai, Turkish, Vietnamese, etc.) are added into the international character set standards (Unicode and ISO), even the 16-bit 2-byte code does not have enough coding space. Therefore, the new international standards (Unicode and ISO) on character sets have to use 32-bit 4-byte code to have enough coding space to handle these additional characters and symbols. Therefore, the frequently used Chinese characters in the older set are using 16-bit 2-byte code whereas many additional infrequently used Chinese characters in the additional new set are using 32-bit 4-byte code.

(4) The e-mail systems and Internet processors used in mainland China, Hong Kong, Taiwan and Singapore conform to the Unicode and ISO standards to handle the 2-byte or 4-byte encoded Chinese characters properly.

(5) On the other hand, many e-mail systems and Internet processors used elsewhere (e.g., USA, Canada, Europe) were originally designed to handle 1-byte ASCII encoded English text. There seems to be little incentive for these e-mail systems and Internet processors to be upgraded to the new Unicode and ISO standard because most of the traffic on such e-mail systems and Internet processors are still predominantly English text. These e-mail systems and Internet processors treat all the traffic as 1-byte encoded English text and strip off the overhead, leading bit of each 8-bit byte. Such manipulation or stripping off of the overhead, leading bit are O.K. for English alphabetic letters because the real English information content are encoded in the ASCII 7-bit portion of the 8-bit byte. 

(6) However, such chopping of 2-byte pair or 4-byte set into individual bytes and stripping off the leading bit of each 8-bit byte corrupt and destroy the 2-byte (16-bit) or 4-byte (32-bit) encoded Chinese characters.

(7) In principle, it is a simple matter to eliminate the problems of destruction of Chinese e-mails by upgrading all the e-mail systems and the Internet processors to the new Unicode and ISO standard so that they can all handle the 2-byte and 4-byte encoded foreign languages properly. However, in real world, many e-mail systems and Internet processors are scattered all over the world in many different computers and servers. It is not a simple matter and may be quite expensive to have all these e-mail systems and Internet processors upgraded properly. Most of the traffic going through many e-mail systems and Internet processors in areas outside of mainland China, Taiwan, Hong Kong and Singapore is heavily dominated by English E-Mails such that there seems to be little incentive to upgrade all these E-Mail systems and Internet processors to the handle the 2-byte and 4-byte encoded Chinese text properly. Therefore, the Chinese e-mails going through international territories have to suffer these corruption and destruction problems for many years to come. 
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